IBM Tivoli NetView for Windows

Release Notes

Version 7.1.2

May 6, 2002
Contents

Introduction  ................................................................. 6
New Features and Enhancements  ........................................ 6
  Enhanced IBM Tivoli Enterprise Console Integration ............... 6
  Installation and Configuration Considerations ...................... 7
    IBM Tivoli Enterprise Console Adapter Configuration during Fresh Installation ........ 8
    IBM Tivoli Enterprise Console Adapter Upgrade during Upgrade Installation .......... 8
    IBM Tivoli Enterprise Console Adapter Configurator from Start Menu ................ 9
  Installing IBM Tivoli Switch Analyzer Rules on IBM Tivoli Enterprise Console Server ... 11
  IBM Tivoli Enterprise Console Server Compatibility ................ 12
New Variable Bindings for NetView Traps  ................................ 12
New NetView Traps and Trap Numbers  .................................. 13
Web MIB Browser Enhancements  ........................................ 14
Web Console Security Enhancement  ..................................... 15
  Passwords  ........................................................................ 15
Web Console Enhancements  ............................................... 15
  Submap Explorer .............................................................. 15
  Object Properties ............................................................ 15
Diagnostics: QuickTest and QuickTest Critical  .......................... 16
Router Fault Isolation (RFI) Enhancements  .............................. 16
  Subnets with Routers – suppress all node downs. .................. 16
  Subnets with some routers known ...................................... 17
  Subnets with no routers .................................................... 17
RFI Configuration ............................................................ 17
New netmon.conf Configuration File ..................................... 18
Status Update Request ...................................................... 18
Introduction

This Release Notes document provides important information about Version 7.1.2 of the IBM Tivoli® NetView® program. These notes are the most current information for the product and take precedence over all other documentation.

This document, together with the Tivoli NetView Release Notes Version 7.1, and the Tivoli NetView for Windows User’s Guide, provides all of the necessary information for planning and performing the installation of IBM Tivoli NetView for Windows Version 7.1.2. Please review these notes thoroughly before installing or using this product.

Please note that the version of IBM Tivoli NetView described in this document is both a complete new installation and an upgrade to IBM Tivoli NetView for Windows Version 7.1 and Version 7.1.1, and all information contained in the Tivoli NetView Release Notes Version 7.1 also applies to IBM Tivoli NetView for Windows Version 7.1.2 unless otherwise noted in this document.

New Features and Enhancements

Enhanced IBM Tivoli Enterprise Console Integration

The integration between IBM Tivoli NetView and IBM Tivoli Enterprise Console has been enhanced to provide automatic event correlation for a default set of finely-tuned network events. This will dramatically improve the ability of event console operators to find the root cause of network-related problems, as well as provide automatic housekeeping by clearing obsolete network status events.

In order to take advantage of this enhanced integration, IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 or later is required. See the nvintegration.pdf file provided with IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 for details about the enhanced integration.

NOTE: Sections 4.2 and 4.2.2 in the nvintegration.pdf document incorrectly state that closed events are synchronized with IBM Tivoli NetView. Version 3.7.1 Fixpack 02 supports synchronization only of acknowledged events.
IBM Tivoli NetView provides a default set of significant events that will be forwarded to the IBM Tivoli Enterprise Console including status events, selected SNMP data collection threshold events, and Router Fault Isolation events. Refer to Table 1 in Appendix A: Event Mapping and New Class Structure for the complete list of events that are forwarded by default.

The event class structure has been modified, including some slot mappings, for IBM Tivoli NetView events that are sent to the IBM Tivoli Enterprise Console. All classes in the new event class structure begin with the prefix "TEC_ITS" instead of "OV". Refer to Table 2 in Appendix A: Event Mapping and New Class Structure for mapping of IBM Tivoli NetView events to the new TEC_ITS classes that are not forwarded by default.

A new NetView ruleset and baroc file are included with IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02. This ruleset provides special event correlation for the new TEC_ITS events. The NetView ruleset is added to the Default rule base by the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 installation, but is not active by default. Refer to the "IBM Tivoli NetView Integration" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README file for the steps required to activate the NetView ruleset. Please refer to the "Known Defects and Limitations" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README. This file describes the current limitations of the NetView ruleset.

Customers upgrading from a previous version of IBM Tivoli NetView may continue to use the old "OV" class structure in order to preserve their own custom rules, but they will not be able to take advantage of the enhanced integration capabilities provided by the new event class structure and rules.

**Installation and Configuration Considerations**

During a fresh installation of IBM Tivoli NetView Version 7.1.2, users have the option of configuring events to be forwarded to an IBM Tivoli Enterprise Console Server using the new default set of significant events.

During an upgrade installation, you have the option to upgrade the IBM Tivoli Enterprise Console Adapter to use the new "TEC_ITS" event class structure and activate forwarding of the new default set of significant events.

If you choose not to upgrade the event class structure, the old "OV" class structure and all user customizations of the IBM Tivoli Enterprise Console Adapter are preserved. If you wish, you may upgrade to the new event class structure.
structure at a later date using the IBM Tivoli Enterprise Console Adapter Configurator.

**IBM Tivoli Enterprise Console Adapter Configuration during Fresh Installation**

The fresh IBM Tivoli NetView Server installation now allows you to configure the IBM Tivoli Enterprise Console Adapter during the installation. If you choose this option, you will be prompted to provide the following information:

- Communication method for the Adapter. You should select "TME" if your machine has the Tivoli Framework installed. Otherwise, you should select "Non-TME".

- If you select the “non-TME” communication method, you must also provide the name, operating system (Microsoft Windows or UNIX), and optionally the port number to be used for communication with the specified IBM Tivoli Enterprise Console Server. You can accept the default port number (“0” for UNIX, “5529” for Microsoft Windows) unless the IBM Tivoli Enterprise Console Server has been customized to use a particular port number. See your IBM Tivoli Enterprise Console system administrator for the proper port number to use.

The IBM Tivoli Enterprise Console Adapter will be configured as follows:

- The IBM Tivoli Enterprise Console Server location and port are written to \usr\ov\conf\tecad_nv6k.conf

- The IBM Tivoli Enterprise Console Adapter [tecad_nv6k.exe] is registered with the ovspmd daemon.

- The IBM Tivoli Enterprise Console Adapter will begin to forward the default set of significant events to the specified IBM Tivoli Enterprise Console Server once the installation has completed and the machine has been rebooted. You can use the IBM Tivoli Enterprise Console Adapter Configurator (accessible from the Start menu) to further customize the Adapter, if desired.

**IBM Tivoli Enterprise Console Adapter Upgrade during Upgrade Installation**

The upgrade IBM Tivoli NetView Server installation allows you to upgrade the IBM Tivoli Enterprise Console Adapter to use the new event class structure and enhanced event forwarding during the installation. If you choose to upgrade, the following actions will take place:
• The current tecad_nv6k.cds, tecad_nv6k.conf, and tecSmartsetFilter.conf files are backed up to \usr\ov\conf\tec*.v6_archive.

• The new tecad_nv6k.cds, tecad_nv6k.conf, and tecSmartsetFilter.conf files are installed with the new event class structure and enhanced event forwarding.

**NOTE:** Old filtering customizations will be lost and the new tecSmartsetFilter.conf file will be empty.

If you choose not to upgrade the Adapter during the installation, you may upgrade to the new event class structure and enhanced event forwarding at any time using the IBM Tivoli Enterprise Console Adapter Configurator (now accessible from the Start menu). The Configurator has been modified to allow you to upgrade to the new event class structure and enhanced event forwarding before configuring the Adapter (it uses the tecad_nv6k.cds file to determine whether the old or new style of events is being used).

You may also choose not to upgrade at all, and continue to use your existing event forwarding with the old "OV" event class structure.

**IBM Tivoli Enterprise Console Adapter Configurator from Start Menu**

A menu item for the IBM Tivoli Enterprise Console Adapter Configurator has been added to the Administration menu under the IBM Tivoli NetView Start menu. It launches \usr\ov\bin\tecconfig.bat. From the **Start** menu, select **Programs -> Tivoli NetView -> Administration -> Configure IBM Tivoli Enterprise Console Adapter**. A command window will appear, followed by the Configure IBM Tivoli Enterprise Console Adapter screen.

The user interface for the Configurator has been enhanced and now provides a Wizard-style interface. If you are using the old "OV" style events (after an upgrade installation), the Configurator will give you the option to upgrade to the new "TEC_ITS" event class structure and start forwarding the default set of significant network events to the IBM Tivoli Enterprise Console. It will determine which event style you are currently using from the tecad_nv6k.cds file. Refer to the "IBM Tivoli Enterprise Console Adapter Upgrade during Upgrade Installation" for detailed information on what the upgrade entails.

The Configurator screen that allows you to select the events that you want forwarded to the IBM Tivoli Enterprise Console has been modified to provide
for the new default set of significant events with special correlation rules. This screen is shown below.

- Check the boxes in the left column that correspond to the events in the right column that you wish to have forwarded to the IBM Tivoli Enterprise Console Server. Events that are forwarded by default, such as TEC_ITS_NODE_STATUS, are not shown.

- If you want to enable override of default event forwarding, check the box at the bottom left of the screen. This box was added to prevent inadvertent removal of events from the list that the IBM Tivoli Enterprise Console rules expect as well as to prevent the addition of SmartSet filtering of the default events.

**NOTE:** You can use this screen if you need to restore the default event forwarding in the IBM Tivoli Enterprise Adapter Configurator.
Uncheck the "Enable override of default event forwarding" checkbox if you want to restore the default settings.

If you selected events in the IBM Tivoli Enterprise Console Adapter screen, the next screen presents a list of events in the left column and a list of SmartSets in the right column. If you want an event to be forwarded only if the node it is associated with is a member of one or more SmartSets, select these SmartSets here. For a given event, if you don’t select any SmartSets, the event will be forwarded without any attempt to filter it out based on SmartSet membership.

**Installing IBM Tivoli Switch Analyzer Rules on IBM Tivoli Enterprise Console Server**

If you are using the optional IBM Tivoli Switch Analyzer, you should upgrade the Default rule base on the IBM Tivoli Enterprise Console Server to take advantage of new rules to correlate IBM Tivoli Switch Analyzer events. These new rules are included in the `netview.rls` file located in the `tec` directory of the IBM Tivoli NetView 7.1.2 CD.

The `tec` directory contains the new `netview.rls` file, the `updnvrules.sh` script, and an `updnvrules.doc` readme file. To install the new `netview.rls` file and activate the ruleset, run the `updnvrules.sh` script on the IBM Tivoli Enterprise Console Server machine. Please read the `updnvrules.doc` file before running this script. In order to use this script, you must first source your Tivoli environment variables, executing `setup_env.sh`, `setup_env.csh` or `setup_env.cmd`. If you are executing on a Windows machine, please run the script under the Tivoli-supplied `bash.exe` shell.

In the “IBM Tivoli NetView Integration” section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README file, the steps required to activate the NetView ruleset are listed. You do not need to perform these steps if you use the `updnvrules.sh` script because the script does these steps automatically. If you have not already included the NetView ruleset as part of the default rule base, this script will automatically include it for you (but beware, it assumes that the existing `netview.baroc` file is in the TEC_CLASSES directory of your Default rule base and that it is compatible with the `netview.rls` file that you are now installing).

**NOTE:** The `updnvrules.sh` script will restart your Event Server to ensure that the new rules will be loaded.
Please refer to the "Known Defects and Limitations" section of the IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 README. This section describes the current limitations of the NetView ruleset.

The new NetView ruleset is supported only on IBM Tivoli Enterprise Console 3.7.1 Fixpack 02 or later. Do not attempt to install this ruleset on an earlier version of IBM Tivoli Enterprise Console.

IBM Tivoli Enterprise Console Server Compatibility

If you are forwarding events from IBM Tivoli NetView to a version of the IBM Tivoli Enterprise Console that is earlier than version 3.7, you must set the Pre37Server flag to YES in the \usr\ov\conf\tecad_nv6k.conf file by adding the entry Pre37Server=YES. You must stop and restart the tecad_nv6k daemon after adding this flag. Use either ovstop/ovstart or Server Setup to stop and restart the daemon.

New Variable Bindings for NetView Traps

New variable bindings (varbinds) have been added to the following IBM Tivoli NetView traps:

- "Subnet Unreachable" and "Subnet Reachable Again" events – varbind 7 will contain the network address of the subnet and varbind 8 will contain the subnet mask.

- All interface events – varbind 7 will contain the IP address of the interface and varbind 8 will contain the interface name. The interface name is the short name assigned to an interface (for example, eth0, hme0). This will be used to uniquely identify the interface on a given node.

- All node events – varbind 7 will be empty (unused) and varbind 8 will contain a comma-separated list of the IP addresses of all the interfaces on the node.

- All router events – varbind 7 and 8 are unused.

- All Layer 2 Status events – varbind 7 will be empty (unused), varbind 8 will contain a comma-separated list of IP addresses for all interfaces on the node, varbind 9 will contain the subnet IP address, and varbind 10 will contain the subnet mask.
New NetView Traps and Trap Numbers

Some NetView traps have been re-numbered in the trapd.conf file to match the IBM Tivoli NetView for UNIX trap numbers. New traps have been added to this file as well. The trapd.conf file will be migrated during an upgrade installation. Customizations to this file will be preserved by the migration.

The following traps have been renumbered:

- **Acknowledge**: 50790450 was 50528264 /* Acknowledge Event for Client/Server */
- **Unacknowledge**: 50790451 was 50528265 /* Unacknowledge Event for Client/Server */
- **IntfUser1**: 58916966 was 58916878 /* Interface USER1 status */
- **NetworkUnreach**: 58916968 was 58916883 /* Network is now unreachable */
- **NetworkReach**: 58916969 was 58916884 /* Network is reachable again */
- **IfaceUnreach**: 58916970 was 58916885 /* Router interface is UNREACHABLE */
- **RouterDown**: 58916971 was 58916886 /* Router is DOWN */
- **RouterUnreach**: 58916972 was 58916887 /* Router is Unreachable */
- **RouterUp**: 58916973 was 58916888 /* Router is UP */
- **RouterMarg**: 58916974 was 58916889 /* Router is Marginal */
- **ServiceUp**: 58916975 was 58916878 /* Service Up */
- **Service Down**: 58916976 was 58916879 /* Service Down */
- **Service Marginal**: 58916977 was 58916880 /* Service Marginal */
- **ServiceAcknowledged**: 58916978 was 58916881 /* Service Acknowledge */
- **ServiceUnacknowledged**: 58916979 was 58916882 /* Service Unacknowledge */
- **ServiceManaged**: 58916980 was 58916915 /* Service Managed */
- **ServiceUnmanaged**: 58916981 was 58916916 /* Service Unmanaged */
- **Service Added**: 58982417 was 58982416 /* Service has been Added */
- **Service Deleted**: 58982418 was 58982417 /* Service has been Deleted */
- **Normalize Object**: 58982416 was 58982418 /* CNAT has translated the node or interface address to a unique address in the management domain */

Three traps have been added for Layer 2 events. These are applicable for systems with the IBM Tivoli Switch Analyzer installed. The Layer 2 traps are:

- **Layer2Up**: 58916984 /* Layer 2 device is UP */
- **Layer2Down**: 58916985 /* Layer 2 device is DOWN */
- **Layer2Marginal**: 58916986 /* Layer 2 device is MARGINAL */

Eight CNAT-related traps are now installed with IBM Tivoli NetView by default (formerly installed by the NetView CNAT Extensions add-on product from the CNAT product CD):

- **CNATP_Started**: 77777770 /* Primary CNAT started */
- **CNATP_Stopped**: 77777771 /* Primary CNAT stopped */
**Web MIB Browser Enhancements**

- **Viewing MIB Table Information**
  
  To view the information for a particular row of the table (for a particular MIB instance), select a cell in the row. The View button will be enabled. Press the View button to display the data.

- **Graphing MIB Table Information**
  
  To graph the MIB values for a particular column of a table (the values for all or some of the MIB instances), select a cell in the column. If the data for that column is graphable, the column will be highlighted and the Graph button will be enabled. Press the Graph button to graph the data.

- **Filtering the MIB Browser Graph**
  
  When you graph a MIB table column, the graph initially displays with all the values for all the MIB instances (all the rows in the table). You can stop the graphing by selecting the Stop button. Once graphing stops, you can request to filter the graph by selecting the Filter button. You are presented with a list of the instances being graphed and can select which elements in the list to graph.

  Like other lists in the Web Console, you can select elements from the list by clicking the left mouse key combined with using the <Shift> and <Ctrl> keys. After marking the desired instances as selected, press the Graph button to begin graphing for just the selected instances.

- **New Timeout pop-up dialog** indicating possible invalid community name or invalid hostname.

- **Improved performance** of timeouts and wait cursors.

**NOTE:** When you are graphing dynamic tables (such as the ipForwardTable), if entries are removed while graphing is active, you will see warning messages in the log. Also, when you refresh dynamic tables, you may see different rows than before.
Web Console Security Enhancement

Passwords

In IBM Tivoli NetView Version 7.1.1, user IDs and passwords were stored in plain text in the NetViewRealm.properties file. In Version 7.1.2, the password will no longer be stored in plain text.

Web Console Enhancements

Submap Explorer

The Submap Explorer now displays connections and backbones in the Unreachable color when the containing network is Unreachable, and provides new telnet functionality. The Submap Explorer will also provide Layer 2 information if the optional IBM Tivoli Switch Analyzer is installed on the server.

- **Layer 2 Information.** The System Configuration View now contains a Layer 2 Status column. This column will be populated only when connected to a UNIX Web Server that has the IBM Tivoli Switch Analyzer installed.

- **New Connection Color for Unreachable.** When displaying submaps that are parented by Unreachable networks, all connections and backbones are now drawn with the Unreachable color.

- **Telnet Command.** The telnet command is now available from the Object option in the main menu and from an object’s pop-up menu in the IBM Tivoli NetView Web Console application. It is not available from the Web Console applet. Please note that you can attempt to telnet to any node, but normally only UNIX nodes have a telnet service available.

Object Properties

Object Properties now provides Layer 2 status, new Interface icons, new Interface health information and new service status information. This version of Object Properties also enables you to quickly know whether a node is in an Unreachable area (by looking at the interface health information or by looking at the new icons that appear in the interface table).

- **Layer 2 Status.** The Other tab of the Object Properties screen now shows the Layer 2 status (currently meaningful only for switches). This column
will be populated only when connected to a UNIX Web Server that has the IBM Tivoli Switch Analyzer installed.

- **Interface Icons.** The interface table now shows an icon for each interface. The center of each interface icon is drawn in the Unreachable color when the interface’s associated network is Unreachable.

- **Interface Health.** The Interface Health shows the percentage health for a node’s interfaces.

- **New Service Table.** The service table displays the last known services available for the target node and, if any of these services are currently Down, the time of failure is also displayed. These "services" are the services that the nvsniffer program has been configured to discover and monitor.

**Diagnostics: QuickTest and QuickTest Critical**

Diagnostics **QuickTest** and **QuickTest Critical** now provide new Interface icons and Results information to enable you to know whether the node being tested is within an Unreachable area.

- **Interface Icons.** The center of each interface icon is now drawn in the Unreachable color when the interface’s associated network is Unreachable.

- **Results Column.** The Results column now contains text about Unreachable networks when a QuickTest or QuickTest Critical is performed for an interface associated with an Unreachable network.

**Router Fault Isolation (RFI) Enhancements**

The Router Fault Isolation (RFI) functionality has been enhanced in three areas:

**Subnets with Routers – suppress all node downs.**

In order to reduce the false signal given by a Node Down event for a device in an Unreachable area, IBM Tivoli NetView does not generate Node Down events for any node in an Unreachable area. The first “node down” that triggers an evaluation resulting in declaring the subnet Unreachable is also suppressed. However, the corresponding “Interface Down” events will continue to be generated until the subnet is declared Unreachable. Afterwards, by default, status polling to Unreachable subnets is suppressed.
Subnets with some routers known

In previous versions, the RFI implementation was such that if there was a back
door to the subnet via a router IBM Tivoli NetView had not discovered, it could
be declared Unreachable when it was not. This resulted in the subnet often
toggling between Unreachable and Marginal. More intelligence has been added
in this release to reduce the chances of a Reachable subnet being declared
Unreachable.

Subnets with no routers

If IBM Tivoli NetView is not managing any routers in a particular subnet, IBM
Tivoli NetView can now determine when that subnet is Unreachable. It does
this using a probabilistic algorithm, inferring when it is highly likely that the
subnet is Unreachable. IBM Tivoli NetView automatically uses this algorithm
for subnets where there are no managed routers. However, this algorithm only
determines the reachability of the subnet. If it is Unreachable, no Node Down
events will be generated.

RFI Configuration

There are three modes for RFI that can be configured:

1. **Disabled** — no attempt will be made to determine reachability or root
   cause. Routers will generate Node status events, instead of the root cause
   Router status events.

2. **Router Fault Isolation Mode** — By dynamically evaluating the status of
   routers, IBM Tivoli NetView will determine the reachability of subnets
   and the root cause of the partition or problem.

3. **Probabilistic Mode** — By dynamically evaluating the status of members
   of a subnet, IBM Tivoli NetView will determine whether it is more likely
   that the subnet itself is Unreachable or whether the device(s) are indeed
down. This mode is disabled if the subnet contains less than a configured
number of managed devices. This mode is automatically used for subnets
with no managed routers if RFI Mode is active. You can fine-tune this
algorithm using properties defined in the new configuration file,
`netmon.conf`. See the `\usr\ov\conf\netmon.conf` file for more details.

To configure the RFI mode, edit the `netmon.conf` file as described in the next
section.
**New netmon.conf Configuration File**

This is a new configuration file for netmon that can be found in the `\usr\ov\conf` directory. You can use this file instead of setting registry variables for the netmon daemon. The values in this file will override any registry variables that are set.

This file also contains configuration properties for the Probabilistic Reachability algorithm.

By default, all properties are commented out, except for the new Reachability properties. To use a property, simply uncomment it and set the property as desired, then stop and restart the netmon daemon.

**Status Update Request**

A new script exists that allows you to prompt IBM Tivoli NetView to bring the status of a device up to date. IBM Tivoli NetView will use the appropriate status mode, SNMP or ICMP, to immediately poll all the interfaces on the device, and will then update the map as necessary.

Applications residing on the IBM Tivoli NetView management station can be configured to automatically invoke this script when they learn of a new status for a device. By making use of the script, these applications can force IBM Tivoli NetView to reflect the new status without waiting for the regular status poll cycle. Applications that do not reside on the IBM Tivoli NetView management station may use the contents of this script to see how to send an SNMP trap to IBM Tivoli NetView to force a status poll without waiting for the regular status poll cycle.

*Usage:*

```
\usr\ov\bin\nvstatusrequest.bat <NetViewServer_hostname or IP_address> <target_hostname or IP_address>
```

**nvmaputil Command Line Interface (CLI) Utility**

A new utility, `nvmaputil`, has been added to enable customers to do some limited management from the command line. This utility provides the ability to dynamically modify a NetView map without recycling the netviewd daemon and all its connected Web Console Submap Explorers. In addition, this utility
enables visibility into which machines are in-scope for the Scopes defined for Web Server account access.

The nvmaputil utility solves the following type of problem for service providers: a misconfigured node from customer A could appear in customer B’s network. In other words, a misconfigured multi-homed node could report one or more IP addresses that actually belong in another customer’s network. When this situation occurs, it is disruptive to stop the netviewd daemon and bring up the native console to fix the problem, as operators would lose any current Submap Explorer connections as soon as the netviewd daemon is stopped.

The specific management functions this utility addresses are as follows:
– Hide/Unhide an interface and its associated node (or nodes).
– Manage/Unmanage an interface or a node.
– Delete all symbols attached to an object.

See Appendix B: nvmaputil Utility for detailed information about the nvmaputil utility.

Other Enhancements

Updates to oid_to_type

The oid_to_type file has been updated with the most current OID information from device vendors.

Supported Platforms

- Windows NT Version 4 with Service Pack 5 or higher
- Windows 2000 with Service Pack 1
System Requirements

The system requirements for IBM Tivoli NetView Version 7.1.2 are identical to those described in the installation and system requirements sections of the *Tivoli NetView Release Notes, Version 7.1* and in the *IBM Tivoli NetView for Windows Release Notes Version 7.1.1*, with the following exception:

IBM Tivoli NetView Version 5 is no longer supported. Users still running Version 5 must upgrade to Version 6 prior to upgrading to Version 7.

Installation Notes

To install IBM Tivoli NetView for Windows Version 7.1.2, follow the instructions in the section "Installing the NetView Program on Windows" in the *Tivoli NetView Release Notes Version 7.1*. A copy of those release notes can be found on the IBM Tivoli NetView for Windows Version 7.1.2 Installation CD-ROM in the *readme* file found in the top level directory of the CD-ROM.

If you are upgrading from a previous version of IBM Tivoli NetView, be sure to remove any old backup directories, such as one that may have been created if you did an upgrade install from Version 6.0 to Version 7.1. Backup directories are located in the \usr directory and are named "ov_00".

Deprecated

Tools -> System Menu

The Tools -> System menu has been deprecated. Tools -> System contained operating system functionality that should be accessed from Windows instead of through the IBM Tivoli NetView Console. The menu options under Tools -> System call the User Manager, Server Manager, Performance Monitor, and SMS Manager.

If you wish to utilize these functions from the Tools -> System menu, you may re-invoke the System menu. To do this, you will need to uncomment a single line from two registration files. Edit the following files:
and uncomment (remove the “#” from) the line (around Line 30) that says:

<95> System

Once the change is made, restart the IBM Tivoli NetView Console.

Defects Fixed in this Release

The following is a list of the customer-reported problems fixed in IBM Tivoli NetView Version 7.1.2, followed by a list of customer-reported problems fixed in IBM Tivoli NetView Version 7.1.1:

<table>
<thead>
<tr>
<th>APAR #</th>
<th>Abstract of Version 7.1.2 Fixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>IY21738</td>
<td>Query SmartSet node doesn’t work for interface selection names</td>
</tr>
<tr>
<td>IY28108</td>
<td>Web Client loses connection if Web Server logged out</td>
</tr>
<tr>
<td>IY28188</td>
<td>Memory management problems in NVCorrD leads to core</td>
</tr>
<tr>
<td>IY28526</td>
<td>SNMP configuration not updated by communityname.conf entry</td>
</tr>
<tr>
<td>IY28719</td>
<td>NVCorrD cores after ruleset change</td>
</tr>
<tr>
<td>IY28730</td>
<td>Segment status incorrect when interface is Admin Down</td>
</tr>
<tr>
<td>IY28834</td>
<td>NVCorrD cores when user script overflows buffer</td>
</tr>
<tr>
<td>IY29129</td>
<td>liblocal ICMP messages may be dropped due to contents</td>
</tr>
<tr>
<td>IY29171</td>
<td>Multiple netmon memory leaks</td>
</tr>
<tr>
<td>PJ28175</td>
<td>NetmonNT core in function checkconninfo</td>
</tr>
<tr>
<td>PJ28374</td>
<td>DISPSUB broken by security patch on NetView Windows</td>
</tr>
<tr>
<td>PJ28402</td>
<td>NetViewNT SNMPCollect cores if conf file too large</td>
</tr>
<tr>
<td>PJ28427</td>
<td>NetViewNT trapfrwd daemon trace log has garbage in it</td>
</tr>
<tr>
<td>PJ28439</td>
<td>NetViewNT NVSniffer sets all objects to WBEM-enabled</td>
</tr>
<tr>
<td>PJ28478</td>
<td>NetViewNT Collection MIB data window not sorting correctly</td>
</tr>
<tr>
<td>PJ28510</td>
<td>Correction of WebServer security leak</td>
</tr>
<tr>
<td>APAR #</td>
<td>Abstract of Version 7.1.1 Fixes</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>IY21803</td>
<td>NVColdD not deleting interface when deleted from IPMAP</td>
</tr>
<tr>
<td>IY22700</td>
<td>Trapd cores using NVAddTrapDConf with large event name</td>
</tr>
<tr>
<td>IY23019</td>
<td>Need duplicate IP address trap when duplicate address found</td>
</tr>
<tr>
<td>IY23828</td>
<td>MAC Addr of 0X000000000000 should be ignored for HSRP</td>
</tr>
<tr>
<td>IY23872</td>
<td>SNMP Status Polling problem during HSRP processing</td>
</tr>
<tr>
<td>IY24405</td>
<td>Cut and Paste of location objects with contents not working</td>
</tr>
<tr>
<td>IY24614</td>
<td>NVDBFormat footer contains incorrect number of objects found</td>
</tr>
<tr>
<td>IY25294</td>
<td>SmartSet object count does not equal that of NVUtil -l</td>
</tr>
<tr>
<td>IY25810</td>
<td>NetView 7.1 IPMAP cores when using location.conf</td>
</tr>
<tr>
<td>IY25905</td>
<td>NetView Web Client problem with newlines in SYSDESCRI</td>
</tr>
<tr>
<td>IY25937</td>
<td>UNIX Polling file location incorrect in 7.1 Release Notes</td>
</tr>
<tr>
<td>IY25971</td>
<td>NVCorrD cores with signal 11 due to memory leaks</td>
</tr>
<tr>
<td>IY26119</td>
<td>SNMP address being changed by NETMON</td>
</tr>
<tr>
<td>IY26404</td>
<td>Unneeded 'address changed' traps during status polling</td>
</tr>
<tr>
<td>IY26581</td>
<td>&quot;Admin Down&quot; Interfaces forcing frequent router checks</td>
</tr>
<tr>
<td>IY26618</td>
<td>New mibloader reporting parsing errors on MIBS</td>
</tr>
<tr>
<td>IY27554</td>
<td>ISACKNOWLEDGED not set to true for non-IP object</td>
</tr>
<tr>
<td>IY28117</td>
<td>Large database causing long Web Client synchronization</td>
</tr>
<tr>
<td>IY28562</td>
<td>NetView fails CERT CA-2002-03 Test Cases</td>
</tr>
<tr>
<td>PJ26715</td>
<td>Error causes nvpager to hang until nvpagerd recycled</td>
</tr>
<tr>
<td>PJ28060</td>
<td>Access Violations when sending events to the TEC Server</td>
</tr>
<tr>
<td>PJ28248</td>
<td>Client mibserver returning wrong values for Cisco router</td>
</tr>
<tr>
<td>PJ28338</td>
<td>DHCP ranges no longer recognized by NETMON</td>
</tr>
<tr>
<td>PJ28350</td>
<td>TCP trap reception on NetViewNT doesn’t seem to work</td>
</tr>
<tr>
<td>PJ28384</td>
<td>Attended MLM discovery table not initialized after discovery</td>
</tr>
</tbody>
</table>
Known Limitations

1. The IBM Tivoli NetView Web Console on Windows should have a minimum of 192 MB of memory.

2. The Autorun feature of the installation CD does not support installations of the NetView Web Console on Windows 98. Users wishing to install Web Consoles on Windows 98 should download \nvwcinstall.exe \n from a NetView server system, or should select \nvwcinstall.exe \n from the NetView CD's netview\i386 directory.

3. The Version 7.1 mib2trap option of mibloader.bat does not recognize the following special comments that begin with "--#".

   --#SUMMARY "Root cause failure: %s %s (%s)"
   --#ARGUMENTS { 2, 1, 0 }
   --#SEVERITY CRITICAL
   --#STATE NONOPERATIONAL
   --#SLOTMAP origin $V1
   --#SLOTMAP hostname $V2
   --#SLOTMAP protocol $V3

4. If you are upgrading to IBM Tivoli NetView Version 7.1.2 and have the TBSM Adapter installed, you will need to contact your IBM/Tivoli representative for an update to the TBSM Adapter.

5. The Tivoli NetView Version 7.1 Release Notes state that the install documentation for CiscoWorks 2000 is included in the \Adapters\Cisco directory of the IBM Tivoli NetView Version 7.1 CD-ROM. This file was inadvertently left off of the IBM Tivoli NetView Version 7.1 CD-ROM; it can be found in the same directory on the IBM Tivoli NetView for Windows NT Version 7.1.2 CD-ROM.

6. We no longer ship the tecad_snmp.baroc, tecad_nv6k.baroc, tecad_ov.baroc and ov_default.rls files with IBM Tivoli NetView Version 7.1.2. They are no longer necessary with the new enhanced integration between IBM Tivoli NetView and IBM Tivoli Enterprise Console.
However, these files are not removed during an upgrade installation for existing customers who still use the old "OV" style event class structure.

A new NetView ruleset file is shipped with IBM Tivoli Enterprise Console 3.7.1 Fixpack 02. Refer to the Fixpack 02 README file for information on activating this new ruleset.

## Documentation Changes

1. In the *Tivoli NetView for Windows User’s Guide*, in the “Using Alternate Community Names” section on page 86, the following section is incorrect:

   Normally, netmon will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use **public**, the default. If this fails, netmon will use the list in the `communityNames.conf` file, but only under the following circumstances...

   It should be changed to:

   Normally, netmon will use the community name from the SNMP configuration. If a name has not been configured for a device, it will use the global default. If this fails, netmon will use the list in the `communityNames.conf` file. The **public** community name will be used only if it is configured for a specific node, configured as the global default, or is listed in the `communityNames.conf` file. Netmon will use the list in the `communityNames.conf` file only under the following circumstances...

2. The *NetView Release Notes for Version 7.1 and 7.1.1 (readme and readmeupd)* should have provided further information about resolution of the potential security problem.

   In the `readmeupd` file (7.1.1 release notes) on page 6, number 5, and in the `readme` file (7.1 release notes) on page 67 and 68, the following text should be included:

   **Security Problem Description**

   There is a potential security problem whereby any non-authorized user, with some knowledge of IBM Tivoli NetView trap customization, could
gain administrator access to the IBM Tivoli NetView system by sending a trap to the IBM Tivoli NetView system from anywhere in the network.

IBM Tivoli NetView version 7.x is not vulnerable with the default configuration as shipped, but this problem can occur after trap customization is done by the IBM Tivoli NetView administrator or by someone with root authority on the IBM Tivoli NetView system. The security hole can be opened when a trap is customized to include a variable in the "Run this command when the trap is received" field. If that field includes a variable as one of the arguments to the action, it is possible for a trap to be sent from anywhere on the network with a command hidden in the variable. This hidden command would then get executed when the configured action gets executed.

**Problem Resolution**

The nvcord and trapd daemons will now filter out all non alpha-numeric characters except for the minus sign ( - ) and the decimal point ( . ). All characters not falling into this set will be replaced with an underscore ( _ ). If a minus sign or decimal point is encountered, it will be escaped (for example, preceded by a backslash (\)) as a precaution. If any non alpha-numeric character is encountered, and filtering is not disabled, a message will be logged in the appropriate log file if logging is enabled.

The user can customize this behavior by creating a registry variable called `AdditionalLegalTrapCharacters` and then stopping and restarting the daemons. If the user sets this variable to the string "disable", then no filtering will be done. If the user sets the variable to a string containing non alpha-numeric characters, then the filtering will allow those characters to also pass through the filter, but they will be escaped.

**Setting the registry for IBM Tivoli NetView**

a. Bring up the registry editor (regedit) from a command window and select:

   HKEY_LOCAL_MACHINE->SOFTWARE->Tivoli ->NetView->
   Current Version
   Right-click on the NetView folder or right-click on the right side of the screen.

   Proceed to step d if "AdditionalLegalTrapCharacters" already exists.

b. Press the right mouse button -> **New** -> string value.
c. Enter/create a new item called:
   AdditionalLegalTrapCharacters

d. Right click on the new variable and select **Modify**.

e. Enter the new value and click **OK**. Here are the valid characters to choose from:
   `! @ # $ % ^ & * ( ) _ + | ~ \ ` \ = - ] [ ' ; / . , ? > < " : } {`

f. Stop and restart the daemons and the new value will be in effect.

   In the previous release, the security changes made for the trap actions caused **dispsub** to break on Windows. The first varbind contains the hostname and the periods are now quoted. This caused the hostname to look like "mynode\.tivoli\.com".

   A fix was made to introduce an option to allow the user the ability to quote or not to quote the so-called legal non-alphanumeric characters. By default, the legal non-alphanumeric characters are the decimal point ( . ) and the minus sign ( - ).

   A new registry value can be added that will control whether a quote character (the backslash "\") is prepended to the legal non-alphanumeric characters:

   `HKEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView\CurrentVersion\QuoteCharacterForLegalTrapCharacters`

   This string value can be left blank to indicate no quoting for legal non-alphanumeric characters or set to "\" to insert quoting. Refer to the instructions above for setting the registry for IBM Tivoli NetView.

3. The documentation (both the manuals and the location.conf file) should warn that a user should not cut from a manually-created location container and paste into a location container that was created by the location.conf file and vice-versa. Also, cutting and pasting between location containers created by the location.conf file is not recommended.

4. On page 79 of the *Tivoli NetView Release Notes Version 7.1*, in the "SQL Databases" section, under "Updating ODBC Components and Access Drivers", the first paragraph (about requiring MDAC 2.0) is still valid. However, the bulleted item in the "Additional Information" section should be removed because **nvdbexport** successfully runs with DAO 3.5 and 3.6. Also, because these versions can be downloaded from the Microsoft site...
shown in the first paragraph, they are no longer shipped on the IBM Tivoli NetView CD.

5. Defect #PJ28050, "Access Violations when sending events to the TEC Server", was fixed in Version 7.1.1 but was omitted from the list of defects reported fixed in this version.

6. In the Tivoli NetView Release Notes Version 7.1, "Installing the Tivoli Integration Pack for Tivoli NetView (TIPN)" was discussed on page 113. The bulleted items in this section are correct, but references to the TIPN CD-ROM are obsolete. As described in the bullet item, the IBM Tivoli Enterprise Console functionality is now incorporated into the base NetView package.

Product Notes

1. This product contains commands, scripts and tools that are not documented in manuals or on-line help which are intended for use by IBM Tivoli service personnel, and are not supported for general customer use.

2. If the IBM Tivoli NetView Server encounters out-of-memory errors, the following dialog will appear on every Web Console that is attached to that server:
   
   The Web Server is unstable.
   Results are unpredictable.
   Contact the NetView administrator.

In addition to these error messages, you will also notice stack traces appearing in the window that launched the Web Console. These stack traces normally mention that a 503 error code was received (for example, "received bad HTTP response code '503'").

If this occurs, the IBM Tivoli NetView administrator should look at \usr\ov\www\logs\netviewservlets.log for any occurrences of the string "OutOfMemoryError":

If such a string is found, the administrator should boost the memory setting that the webserver uses. This can be done as follows:

a. Stop the Web Server using the command ovstop webserver.
b. Modify the file \usr\ov\lrf\webserver.lrf by changing the single instance of the "Xmx64m" string to be something larger, like "Xmx96m". The "Xmx" setting is used to specify the maximum size of Java’s memory allocation pool. The IBM Tivoli NetView program ships with the default set to "Xmx64m" (64MB).

c. Register the webserver with ovaddobj \usr\ov\lrf\webserver.lrf.

d. Start the Web Server using the command ovstart webserver.

3. In general, devices that support the dot1dBridge MIB are supported by the new Diagnostics Switch Management views.

4. The new MPLS Management views are supported on devices that support the MPLS LSR MIB.

5. Use of the standard Windows Notepad or WordPad editors to manually modify IBM Tivoli NetView customization and configuration files can result in special editing characters being placed in the files. These editing characters cause the file to appear corrupted to IBM Tivoli NetView. To ensure this does not happen, use the appropriate customization and configuration mechanisms provided by the IBM Tivoli NetView user interface or as described in the Tivoli NetView for Windows User’s Guide.

6. The Web Console should be upgraded to Version 7.1.2 on all systems. However, doing so will result in the loss of the list of hosts and ports to which the Web Console has been previously connected that appears in the login dialog. This list can be retained by saving the file lib\properties\DefaultHostAndPort.properties in the Web Console install directory before upgrading, and then copying it back afterwards, overwriting the newly-installed version.

7. When migrating from IBM Tivoli NetView for Windows Version 7.1, the following files are archived into \usr\ov\vn_archive, where vn is the version you are upgrading from, and replaced with newer versions:
   \usr\ov\vn_archive\lrf\webserver.lrf
   \usr\ov\vn_archive\reg\advanced\c\nvcnat.reg
   \usr\ov\vn_archive\reg\beginner\c\nvcnat.reg
   \usr\ov\vn_archive\www\webapps\netview\log4j.properties
When migrating from IBM Tivoli NetView for Windows Version 7.1 or 7.1.1, the following files are archived into \usr\ov\n\vn_archive, where \vn is the version you are upgrading from, and replaced with newer versions:
\usr\ov\vn_archive\reg\advanced\c\lmapps.reg
\usr\ov\vn_archive\reg\advanced\c\ovhpux\nnm-hpux.rsam
\usr\ov\vn_archive\reg\beginner\c\lmapps.breg
\usr\ov\vn_archive\reg\beginner\c\ovhpux\nnm-hpux.rsam
\usr\ov\vn_archive\www\conf\jetty.xml

8. The **nvturbocompress** utility is designed to compress the object database. After many adds and deletes of objects, the database can get very fragmented. Using this utility can reduce the disk space used. This utility became available in NetView NT Version 6.0.3, but was inadvertently omitted from the release notes. The **nvturbocompress** utility can be found in the \usr\ov\service directory.

9. If you encounter any problems with the new **telnet** option, verify that the TELNET_COMMAND path is correct in the \usr\ov\bin\nvwc.bat file.

10. Starting with IBM Tivoli NetView Version 7.1.1, the IBM Tivoli NetView CNAT components formerly installed as an add-on to IBM Tivoli NetView from the Comprehensive Network Address Translator product distribution (product number 5698-NAT) are now part of the standard IBM Tivoli NetView product.

The nvCNAT components add the **CNAT Operations** menu options under the **Tools** menu. These menu options enable IBM Tivoli NetView to discover all CNAT devices in your network and to automatically download all information necessary to identify all nodes in the network that IBM Tivoli NetView has discovered which have IP addresses that have been translated by the CNAT devices. Node symbols (and the affected interface symbols) that have had their IP addresses translated by a CNAT system will have a "***" prefix and suffix added to the label name. For example, if node "systema.company.com" has an interface with an IP address that has been translated by a CNAT, the node's symbol label will be modified to "***systema.company.com***", and the corresponding interface symbol label will also contain the added "***" prefix and suffix.
If you already have nvCNAT installed, it will automatically be migrated if you are upgrading to IBM Tivoli NetView Version 7.1.2, and the nvCNAT uninstaller is automatically disabled to prevent accidental loss of nvCNAT capability.

In addition, CNAT traps are added to trapd.conf, and the following files are archived into \usr\ov\vn_archive during an upgrade migration, where vn is the version you are upgrading from, and replaced with newer versions:

- \usr\ov\vn_archive\reg\advanced\c\nvnat.reg
- \usr\ov\vn_archive\reg\beginner\c\nvnat.reg

For additional nvCNAT product information, please refer to the CNAT Guide and Reference located on the CNAT product CD.

11. To send IBM Tivoli NetView Web Console log messages to a file, edit one of the following files:

   If you installed the Server (running from \usr\ov\bin\nvwc.bat), edit this file:
   \usr\ov\www\webapps\netview\log4j.properties

   If you installed the Web Console only, edit this file:
   <web_console_dir>\lib\log4j.properties
   where web_console_dir is the directory where the Web Console is installed.

   If running from the IBM Tivoli NetView Web Console applet, edit this file:
   \usr\ov\www\webapps\netview\log4j.properties
   [on the webservers]

   Edit log4j.properties by adding the following lines (after the existing ConsoleAppender):

   log4j.appender.R=org.apache.log4j.RollingFileAppender
   # Specify the file where you want the output to go.
   log4j.appender.R.File=/usr/OV/www/logs/webconsole.log
   log4j.appender.R.MaxFileSize=100KB
   # Keep one backup file
log4j.appender.R.MaxBackupIndex=1
log4j.appender.R.layout=org.apache.log4j.PatternLayout
log4j.appender.R.layout.ConversionPattern=%d{ISO8601} [%t] %-5p %c %x - %m%n

Modify the line:

log4j.rootCategory=INFO, A1
to be:

log4j.rootCategory=INFO, A1, R

**NOTE:** This adds the new file appender to the category.

To turn on debugging for a particular IBM Tivoli NetView category or component, modify the line for that particular category (for example, snmp) as shown below.

Change:

log4j.category.com.tivoli.netview.snmp=INFO
to:

log4j.category.com.tivoli.netview.snmp=DEBUG

12. If you install IBM Tivoli Enterprise Console Version 3.7.1 Fixpack 02 on a machine that also has the IBM Tivoli NetView Version 7.1.2 server installed, you must separately install the IBM Tivoli NetView Web Console if you wish to perform integrated product launching. This integrated product launching enables you to select an event in the IBM Tivoli Enterprise Console and perform a context launch of Submap Explorer, Object Properties or Diagnostics. The launch request results in a new Submap Explorer, Object Properties or Diagnostics view within an IBM Tivoli NetView Web Console and the context of the launch will be the hostname associated with the originally-selected IBM Tivoli Enterprise Console event. See "Installing the NetView Web Console" in the *Tivoli NetView Release Notes Version 7.1* for information on installing the IBM Tivoli NetView Web Console.
Installing and Using the IBM Tivoli NetView Language Kits

This section provides important information about installing and using the IBM Tivoli NetView for Windows Version 7.1.2 Language Kit. Please read this section thoroughly before installing or using the Language Kit.

IBM Tivoli NetView Version 7.1.2 has new language kits. If you are upgrading from IBM Tivoli NetView Version 7.1.1 to Version 7.1.2, you must also install the Version 7.1.2 Language Kit.

Supported Languages

IBM Tivoli NetView for Windows Version 7.1.2 provides files for the following languages:

- English
- Japanese
- Korean
- Simplified Chinese

Installation Requirements

The following hardware and software prerequisites must be met before installing the Tivoli NetView Language Kit:

- An Intel PC is required.
- For NT: Version 4.0, Service Pack 5 or higher (Professional or Server)
- For Windows 2000: Service Pack 1 (Professional or Server)
- IBM Tivoli NetView for Windows Version 7.1.2 base English kit
- 40 MB disk space on the NetView installation drive
- Internet Explorer Version 5.0 or higher or Netscape Version 4.5 or higher
Installing the IBM Tivoli NetView Language Kit

The following checklist provides the list of tasks you must complete in order to successfully install the IBM Tivoli NetView Language Kit.

1. Install a language-specific version of the Microsoft Data Access Components.

   Refer to "Updating ODBC Components and Access Drivers" in the Tivoli NetView Release Notes Version 7.1 for information about the Microsoft Data Access Components. For more information about Microsoft Data Access Components, see http://www.microsoft.com/data.

   The language-specific MDAC kit can be installed before or after the IBM Tivoli NetView Language Kit is installed. If a language-specific MDAC kit isn’t installed, ODBC error messages might be displayed in English.

2. Install the IBM Tivoli NetView for Windows Version 7.1.2 base English kit. The IBM Tivoli NetView base kit must be installed before the Language Kit. The Language Kit is installed on top of the base kit. This kit is located on the IBM Tivoli NetView for Windows Version 7.1.2 CD-ROM that is included with the NetView distribution. Refer to the Tivoli NetView Release Notes Version 7.1 for instructions on how to install the base kit.

3. Reboot the machine.

   If the machine is not rebooted before installing the IBM Tivoli NetView Language Kit, the installation may fail.

4. Close the NetView Program Group window if it is open. If the NetView Program Group window is open when installing the Language Kit, the items in the NetView Program Group and the NetView menu items in the Windows Start menu will be lost.

5. Install the IBM Tivoli NetView Language Kit.

   Click on “Install NetView Language Kit” in the IBM Tivoli NetView installation AutoOpen window or double-click on the cd-drive:\NetView\nvlang.exe file on the CD-ROM to install the IBM Tivoli NetView Language Kit.
During the installation you are prompted to choose the language for the IBM Tivoli NetView menu items in the Windows Start menu: English, Japanese, Korean, or Simplified Chinese. In most cases, the default will be the appropriate language. English is supported on all operating systems.

**Upgrading from a Previous Language Kit**

The upgrade path for Version 6.0 or Version 7.1.1 with Language Kit to Version 7.1.2 with Language Kit is as follows:

1. Upgrade the base kit, which archives customizable Language Kit files and deletes non-customizable Language Kit files.

2. Install the new Language Kit. Afterwards you can merge customizations into the new Language Kit files if you wish.

**About the IBM Tivoli NetView Web Console**

The translated version of the IBM Tivoli NetView web site is located at `http://host:8080/xx` where `host` is the name of the IBM Tivoli NetView Web Server system and `xx` is the desired locale (`zh`, `ja`, or `ko`). This web site contains information about the IBM Tivoli NetView Web Console.

If you would like to run the Web Console in a language other than the default language for the system, modify `\usr\ov\bin\nvwc.bat`, adding `-Duser.language=xx` immediately before `-Xmx64m` on the command line for launching the Web Console. Substitute the `xx` with `en` for English, `ja` for Japanese, `ko` for Korean, or `zh` for Chinese.

**Language Kit Restrictions**

This section describes restrictions and known problems for the IBM Tivoli NetView Language Kit.

**Client/Server**

- The IBM NetView Client can connect only to an IBM NetView Server that uses the same locale. The exception to this rule is that any Client can
connect to a Server using an English locale. A Client will display English when it is connected to an English Server.

Web Console/Web Server

- The IBM Tivoli NetView Web Console and IBM Tivoli NetView Web Server systems must use the same locale. Running the IBM Tivoli NetView Web Console and Web Server in mixed locales is not supported. It will result in malformed characters appearing in the maps and menus, and some of the functions will not work.

MultiLanguage User Interface (MUI) on Windows 2000

- The IBM Tivoli NetView Server automatically runs in the base language of the Windows operating system, regardless of what other languages have been installed.

- To switch the language of the NetView Server you must log in to an account with the desired language and stop and restart the Server by typing `net stop netview` and then `ovstart`. This will switch the IBM Tivoli NetView Server's language to the system default locale for that user account. The Server will revert to the base language each time the system is rebooted.

- Stopping and restarting individual NetView daemons may result in some daemons running in the base language and some running in the language of the account you are logged in to. This is not supported.

- The language that is enabled when you run the native IBM Tivoli NetView Console for the first time after a fresh installation is the language used for naming the Root submap. If you switch to another language, the name for the Root submap might not display correctly. The only way to reset the Root submap name is to clear the database and restart discovery.

- If multi-byte characters in submap symbol labels don’t display correctly, select a new font by following these steps:
  
  a. In the IBM Tivoli NetView console, select **Options -> Console Settings**.

  b. At the bottom of the General tab, select **Object Label Font**. Select a new font from the list, select a different option from the Script pull-down menu if applicable, then press **OK**.
The MS UI Gothic font is an example of a font that might be used for the Japanese language.

c. After the Object Label Font screen closes, press **Apply** or **OK** in the Console Settings window and the font for the symbol labels will be updated.

**Translation Support**

Programmer commands and functions, advanced administrative tasks, information primarily used by Tivoli Support for problem diagnosis, and SNMP data (which is, by its nature, English only) are not translated or enabled for multi-byte characters.

The following information is not translated:

- Base and Language Kit installations
- API definitions, command line utilities and program samples
- Database field names and enumerated values
- Default SmartSet names and descriptions
- Symbol class/subclass names and status values
- SNMP community names (must be ASCII characters)
- MIB object names, descriptions, and enumerated values
- Trap names and descriptions
- Program samples, most configuration files, command line utilities
- Tracing and logging messages, with the exception of some messages in the **nv.log** file
- Programmer’s Guide and Programmer’s Reference
- There are no translated versions of the MLM
- The Web Console desktop shortcut is not translated
- The default Role names in Web Console Security
- Segment submap names

The following applications are neither translated nor enabled for multi-byte characters:

- deathtrap.exe
- nvdbexport.exe
- nvdbimport.exe
The following menu items are not available in the IBM Tivoli NetView Console menu when displaying Japanese, Korean, or Simplified Chinese:

- Tools->DMI menu items
- Tools->WBEM menu items
- Tools->Wired for Mgmt->Wake on LAN
- Tools->Summary Report

The Frequently Asked Questions document is not available from the NetView Program Group if English is not chosen for the Start menu items when installing the Language Kit.

**Language Kit Notes**

This section provides general product information for the Language Kit.

**Web Console Interoperability Issues**

Read the *Tivoli NetView Release Notes Version 7.1* if you experience problems with an IBM Tivoli NetView Web Console that is connected to an IBM Tivoli NetView Web Server running on a UNIX platform.

**Web Browser Configuration for Use with the NetView Web Console**

If you are using the Netscape Communicator or Navigator to access the IBM Tivoli NetView Web Console, you will need to configure the following settings in Netscape:
• **Edit -> Preferences... Appearance... Fonts** to specify the font to use from the **For the Encoding** list.

• **View -> Character Set -> Unicode (UTF-8)** to select the UTF-8 character set.

For more information on these settings, refer to the URL [http://home.netscape.com/eng/intl/basics.html](http://home.netscape.com/eng/intl/basics.html)

If you are using Internet Explorer, follow these steps to configure the fonts:

• Select **Tools -> Internet Options... Fonts**, then select from **Language script** list, and choose a corresponding Web page font and Plain text font. If the page still doesn’t display correctly, select **View -> Encoding -> Unicode (UTF-8)**.

**Monitor Resolution**

It is important to have a monitor with the appropriate resolution. The recommended dimensions are 1280 x 1024 pixels or higher.

**Date Order Incorrect in Calendar Widget**

On Windows NT 4.0, the date order in the calendar widget used within the IBM Tivoli NetView for Windows application may display month and year in the wrong order in non-English environments. This problem does not occur under Windows 2000 and appears to be caused by a defect in the Windows NT operating system.

**Font Quality Issues with Web Console**

The JREs for all platforms for which the NetView application offers National Language Support use font settings which may result in the display of unattractive fonts in non-English environments.

To overcome this problem, IBM recommends the use of its World-Type font set. Please contact your customer representative for information on how to obtain WorldType fonts and how to configure your JRE to use these fonts.

**IBM Tivoli Enterprise Console Language Kit Compatibility**

If you are forwarding events to a version of the IBM Tivoli Enterprise Console that is earlier than version 3.7, you must add the following flags to the `\usr\ov\conf\tecad_nv6k.conf` file:
• Set the **Pre37Server** flag to **YES** by adding the entry `Pre37Server=YES`.

• Set the **Pre37ServerEncoding** flag to the Tivoli encoding at the event server. See the Tivoli Management Framework User’s Guide for additional information about Tivoli text encoding support.

After adding these flags you must stop and restart the tecad_nv6k daemon by typing:

```
\usr\ov\bin\ovstop tecad_nv6k
\usr\ov\bin\ovstart tecad_nv6k
```
Appendix A:
Event Mapping and New Class Structure

Table 1 shows the events that are forwarded by default.

<table>
<thead>
<tr>
<th>ClassName</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td></td>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>DELETED</td>
</tr>
<tr>
<td>Interface deleted</td>
<td>OV_If_Deleted</td>
<td>58785793 (IntfDeleted)</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td></td>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>Interface unmanaged</td>
<td>OV_Unmanage_IF</td>
<td>50790442 (UnmanageIntf)</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_STATUS</td>
<td></td>
<td>TEC_ITS_INTERFACE_STATUS</td>
<td></td>
</tr>
<tr>
<td>Interface Up</td>
<td>OV_IF_Down</td>
<td>58916886 (IntfUp)</td>
<td>UP</td>
</tr>
<tr>
<td>Interface Down</td>
<td>OV_IF_Down</td>
<td>58916887 (IntfDown)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Interface Admin Down</td>
<td>NEW</td>
<td>58916966 (IntfUser1)</td>
<td>AdminDown</td>
</tr>
<tr>
<td>Interface Unreachable</td>
<td>NEW</td>
<td>58916970 (IfaceUnreach)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>TEC_ITS_ISDN_STATUS</td>
<td></td>
<td>TEC_ITS_ISDN_STATUS</td>
<td></td>
</tr>
<tr>
<td>ISDN Active</td>
<td>NEW</td>
<td>58916982 (ISDNBackActive)</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>ISDN Dormant</td>
<td>NEW</td>
<td>58916983 (ISDNBackDormant)</td>
<td>DORMANT</td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td></td>
<td>TEC_ITS_NODE_ADDED</td>
<td>DELETED</td>
</tr>
<tr>
<td>Node deleted</td>
<td>OV_Node_Deleted</td>
<td>58785795 (NodeDeleted)</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td></td>
<td>TEC_ITS_NODE_MANAGE</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>Node unmanaged</td>
<td>OV_Unmanage_Node</td>
<td>50790419 (UnmanageNode)</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_STATUS</td>
<td></td>
<td>TEC_ITS_NODE_STATUS</td>
<td></td>
</tr>
<tr>
<td>Node Up</td>
<td>OV_Node_Down</td>
<td>58916864 (NodeUp)</td>
<td>UP</td>
</tr>
<tr>
<td>Node Down</td>
<td>OV_Node_Down</td>
<td>58916865 (NodeDown)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Node Marginal</td>
<td>OV_Node_Marginal</td>
<td>50790400 (NodeMarginal)</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_ROUTER_STATUS</td>
<td></td>
<td>TEC_ITS_ROUTER_STATUS</td>
<td></td>
</tr>
<tr>
<td>Router Down</td>
<td>NV_Router_Status</td>
<td>58916971 (RouterDown)</td>
<td>DOWN</td>
</tr>
<tr>
<td>Router Unreachable</td>
<td></td>
<td>58916972 (RouterUnreach)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>Router Up</td>
<td></td>
<td>58916973 (RouterUp)</td>
<td></td>
</tr>
<tr>
<td>Router Marginal</td>
<td></td>
<td>58916974 (RouterMarg)</td>
<td>MARGINAL</td>
</tr>
<tr>
<td>TEC_ITS_SNMPCOLLECT_THRESHOLD</td>
<td></td>
<td>TEC_ITS_SNMPCOLLECT_THRESHOLD</td>
<td></td>
</tr>
<tr>
<td>SNMP Collect threshold exceeded</td>
<td>OV_DataCollectThresh</td>
<td>58720263 (CollDetThresh)</td>
<td>THRESHOLD_EXCEEDED</td>
</tr>
<tr>
<td>SNMP Collect re-arm threshold</td>
<td>OV_DataCollect_Rearm</td>
<td>58720264 (CollRe-arm)</td>
<td>REARMED</td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_CONNECTIVITY</td>
<td></td>
<td>TEC_ITS_SUBNET_CONNECTIVITY</td>
<td></td>
</tr>
<tr>
<td>Subnet Unreachable</td>
<td>NV_Subnet_Reachability</td>
<td>58916968 (NetworkUnreach)</td>
<td>UNREACHABLE</td>
</tr>
<tr>
<td>Subnet Reachable again</td>
<td></td>
<td>58916969 (NetworkReach)</td>
<td>REACHABLE_AGAIN</td>
</tr>
</tbody>
</table>
Table 1: Events Forwarded by Default

<table>
<thead>
<tr>
<th>ClassName</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_L2_NODE_STATUS Layer 2 device is UP</td>
<td>NEW</td>
<td>58916984 (Layer2Up)</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_L2_NODE_STATUS Layer 2 device is DOWN</td>
<td>NEW</td>
<td>58916985 (Layer2Down)</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_L2_NODE_STATUS Layer 2 device is MARGINAL</td>
<td>NEW</td>
<td>58916986 (Layer2Marginal)</td>
<td>MARGINAL</td>
</tr>
</tbody>
</table>

NOTE: TEC_ITS_SA_STATUS events are also forwarded by default. See documentation for the optional IBM Tivoli Switch Analyzer product for more information.

Table 2 shows event mappings and new class structure for events not listed in Table 1.

Table 2: Mappings between Events and New Class Structure

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Replaces</th>
<th>Event</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEC_ITS_APPLICATION_ALERT</td>
<td>NV6K_Application_Alert</td>
<td>59047936</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_APPLICATION_STATUS</td>
<td>NV6K_Application_Up_Event</td>
<td>5919056</td>
<td>UP</td>
</tr>
<tr>
<td>TEC_ITS_APPLICATION_STATUS</td>
<td>NV6K_Application_Down_Event</td>
<td>5917905</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS ASN MIB DEF_FILE_FORMAT</td>
<td>NV6K_ASN_MIB_Def_File_Format</td>
<td>50790439</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_BAD_SUBNET_MASK</td>
<td>OV_Bad_Subnet_Mask</td>
<td>58982414</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_IF_SEGMENT</td>
<td>OV_Chg_If_Segment</td>
<td>50790427</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_NETMON_RETRY_COUNT</td>
<td>NV6K_Change_Netmon_Retry_Count</td>
<td>59179070</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CHANGE_POLLING_PERIOD</td>
<td>OV_Change_Polling_Period</td>
<td>50790411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CMIS_EVENT</td>
<td>OV_CMIS_Event</td>
<td>58916870</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_CONNECTION_ADDED</td>
<td>OV_Connection_Added</td>
<td>50790409</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_CONNECTION_ADDED</td>
<td>OV_Connection Deleted</td>
<td>50790410</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_CPU_LOAD</td>
<td>NV6K_Cpu_Load</td>
<td>58720256</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_DISK_SPACE</td>
<td>NV6K_Disk_Space_Percentage_Used</td>
<td>58720257</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_ERROR</td>
<td>OV_Error</td>
<td>58851329</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FATAL_ERROR</td>
<td>OV_Fatal_Error</td>
<td>58851330</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FORCED_POLL</td>
<td>NV6K_Forced_Poll</td>
<td>50790412</td>
<td>START</td>
</tr>
<tr>
<td>TEC_ITS_FORCED_POLL</td>
<td>NV6K_Cancel_Forced_Poll</td>
<td>50790413</td>
<td>CANCELLED</td>
</tr>
<tr>
<td>TEC_ITS_FORW_STATUS_CHG</td>
<td>OV_Forw_Status_Chg</td>
<td>58982407</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_FORWARDING_TO_A_HOST</td>
<td>NV6K_Forwarding_To_A_Host</td>
<td>58982408</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_HSRP_ADDED</td>
<td>NV6K_Hsp_Added</td>
<td>58785796</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_HSRP_ADDED</td>
<td>NV6K_Hsp_Deleted</td>
<td>58785797</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_IF_CRC_ERROR</td>
<td>NV6K_Interface_Crc_Errors</td>
<td>58720260</td>
<td></td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>TEC_ITS_IF_DESC_CHANGED</td>
<td>OV_If_Desc_Chg</td>
<td>58982413</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_FLAGS_CHANGED</td>
<td>OV_If_Flags_Chg</td>
<td>50790446</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_DEFERRED</td>
<td>NV6K_Interface_Percent_Devurred</td>
<td>58720258</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_COLLISIONS</td>
<td>NV6K_Interface_Percent_Collision</td>
<td>58720259</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_INPUT_ERRORS</td>
<td>NV6K_Interface_Percent_Input_Errors</td>
<td>58720261</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_PERCENT_OUTPUT_ERRORS</td>
<td>NV6K_Interface_Percent_Output_Errors</td>
<td>58720262</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_POSITION_CHANGED</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Interface_Position_Changed</td>
<td>50790447</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_IF_TYPE_CHANGED</td>
<td>OV_If_Type_Changed</td>
<td>58982412</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_ADDED</td>
<td>OV_If_Added</td>
<td>58785792</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_INTERFACE_MANAGE</td>
<td>OV_Manage_If</td>
<td>50790441</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_MAP_CHANGE</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Map_Change_Event</td>
<td>59113474</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_ACTION</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Netmon_Action</td>
<td>50790426</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_FILE</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Netmon_Change_Trace_File</td>
<td>50790422</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_CHANGE_TRACE_MASK</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Netmon_Change_Trace_Mask</td>
<td>50790423</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_NODE</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Netmon_Dump_Node</td>
<td>50790424</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETMON_DUMP_INTERFACE</td>
<td>(Windows Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NV6K_Netmon_Dump_Interface</td>
<td>50790425</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_ADDED</td>
<td>OV_Network_Added</td>
<td>50790407</td>
<td>ADDED</td>
</tr>
<tr>
<td></td>
<td>OV_Network_Deleted</td>
<td>50790408</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_FLAGS_CHANGED</td>
<td>OV_Network_Flg_Chg</td>
<td>50790443</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_MANAGE</td>
<td>OV_Manage_Network</td>
<td>50790416</td>
<td>MANAGE</td>
</tr>
<tr>
<td></td>
<td>OV_Unmanage_Network</td>
<td>50790417</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NETWORK_STATUS</td>
<td>OV_Network_Normal</td>
<td>50790403</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>OV_Network_Marginal</td>
<td>50790404</td>
<td>MARGINAL</td>
</tr>
<tr>
<td></td>
<td>OV_Network_Critical</td>
<td>58978689</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_NODE_ADDED</td>
<td>OV_Node_Added</td>
<td>58785794</td>
<td>ADDED</td>
</tr>
<tr>
<td>TEC_ITS_NODE_FLAGS_CHANGED</td>
<td>OV_Node_Flags_Chg</td>
<td>50790445</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_NODE_MANAGE</td>
<td>OV_Manage_Node</td>
<td>50790418</td>
<td>MANAGE</td>
</tr>
<tr>
<td>TEC_ITS_NO_SNMP_REPLY</td>
<td>OV_No_Snp_Reply</td>
<td>58982409</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_OBJECT_ID_CHANGE</td>
<td>OV_Object_Id_Chg</td>
<td>58982403</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_CHANGED</td>
<td>OV_Phys_Addr_Chg</td>
<td>58982400</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_PHYS_ADDR_MISMATCH</td>
<td>OV_Phys_Addr_Mismatch</td>
<td>58982401</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_ADDED</td>
<td>OV_Segment_added</td>
<td>50790405</td>
<td>ADDED</td>
</tr>
<tr>
<td></td>
<td>OV_Segment_Deleted</td>
<td>50790406</td>
<td>DELETED</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_FLAGS_CHANGED</td>
<td>OV_Segment_Flag_Chg</td>
<td>50790444</td>
<td></td>
</tr>
<tr>
<td>Class Name</td>
<td>Replaces</td>
<td>Event</td>
<td>Status</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------</td>
<td>----------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_MANAGE</td>
<td>OV.Manage_Segment</td>
<td>50790420</td>
<td>MANAGE</td>
</tr>
<tr>
<td></td>
<td>OV.Unmanage_Segment</td>
<td>50790421</td>
<td>UNMANAGE</td>
</tr>
<tr>
<td>TEC_ITS_SEGMENT_STATUS</td>
<td>OV.Segment_Marginal</td>
<td>50790401</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>OV.Segment_Marginal</td>
<td>50790402</td>
<td>MARGINAL</td>
</tr>
<tr>
<td></td>
<td>OV.Segment_Critical</td>
<td>58916868</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVER_STATUS</td>
<td>NV6K.Up</td>
<td>58916964</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>NV6K.Down</td>
<td>58916965</td>
<td>DOWN</td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_POINT_APPL_CHANGED_MASK</td>
<td>NV6K_Service_Point_Appl_Changed_Mask</td>
<td>59179069</td>
<td></td>
</tr>
<tr>
<td>(Windows Only)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SERVICE_STATUS</td>
<td>NEW</td>
<td>58916976</td>
<td>UP</td>
</tr>
<tr>
<td></td>
<td>NV_Service_Down</td>
<td>58916976</td>
<td>Down</td>
</tr>
<tr>
<td>TEC_ITS_SNMP_DATA_COL_FILE_FORMAT</td>
<td>NV6K.Sys_Data_Col_File_Format</td>
<td>50790440</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SNMP_STATUS_CHANGE</td>
<td>NV6K.Snmp_Status_Change</td>
<td>58916871</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SUBNET_MASK_CHANGED</td>
<td>OV.Subnet_Mask_Chg</td>
<td>58982406</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_CONTACT_CHANGED</td>
<td>OV.Sys_CONTACT_Chg</td>
<td>58982410</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_DESCR_CHANGED</td>
<td>OV.Sys_Desc_Chng</td>
<td>58982404</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_LOCATION_CHANGED</td>
<td>OV.Sys_Location_Chg</td>
<td>58982411</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_SYS_NAME_CHANGED</td>
<td>OV.Sys_Name_Chg</td>
<td>58982405</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRALERT_CHANGE_TRACEMASK</td>
<td>NV6K_Tralert_Change_Tracemask_Event</td>
<td>59179068</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_TRAP_CONF_FORMAT_CHANGED</td>
<td>NV6K_TRAPD.CONF_Format_Changed</td>
<td>50790438</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_THRESHOLD_CHANGE</td>
<td>NV6K_Set_Threshold</td>
<td>50790414</td>
<td>SET</td>
</tr>
<tr>
<td></td>
<td>NV6K_Delete_Threshold</td>
<td>50790415</td>
<td>DELETE</td>
</tr>
<tr>
<td>TEC_ITS_UNDETERMINED_LINK_LEVEL_ADDR</td>
<td>NV6K_Undetermined_Link_Level_Addr</td>
<td>58982402</td>
<td></td>
</tr>
<tr>
<td>TEC_ITS_WARNING</td>
<td>NV6K_Warnings</td>
<td>50462720</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: nvmaputil Utility

Usage

\usr\OV\bin\nvmaputil

[-h | --help]
[--mapname map_name]
[--delete selection_name1 ... selection_nameN]
[--hide-symbol symbolID1 ... symbolIDN]
[--unhide-symbol symbolID1 ... symbolIDN]
[--hide-interface-and-node ip_address1 ... ip_addressN]
[--unhide-interface-and-node ip_address1 ... ip_addressN]
[--manage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]
[--unmanage-node hostname_or_ip_address1 ... hostname_or_ip_addressN]
[--manage-interface ip_address1 ... ip_addressN]
[--unmanage-interface ip_address1 ... ip_addressN]
[--scopeinfo scope_info_filename]
[--dump-scopes | dump-scope scope_name]
[--dump-definitions <true_or_false>]
[--dump-nodes <true_or_false>]
[--dump-node-interfaces <true_or_false>]
[--dump-interfaces <true_or_false>]
[--dump-router-overlaps <true_or_false>]
[--dump-node-overlaps <true_or_false>]
[--logconfig log4j_config_file]
Where:

- `-h, --help` display this help and exit

- `--mapname` the currently opened read/write map to use

- `--delete` OVwDB selection names for which all associated symbols are to be deleted

- `--hide-symbol` mapdb symbol IDs to hide (use ovmapdump to obtain symbol IDs)

- `--unhide-symbol` mapdb symbol IDs to unhide (use ovmapdump to obtain symbol IDs)

- `--hide-interface-and-node` one or more IP addresses, where each IP address entry results in hiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it’s an “isConnector” device)

- `--unhide-interface-and-node` one or more IP addresses, where each IP address entry results in unhiding both an interface symbol and its associated segment-level node symbol and, if needed, its associated network-level node symbol as well (if it’s an “isConnector” device)

- `--manage-node` one or more hostnames or IP addresses, where each one corresponds to a node to be managed

- `--unmanage-node` one or more hostnames or IP addresses, where each one corresponds to a node to be unmanaged

- `--manage-interface` one or more IP addresses, where each one corresponds to an interface to be managed

- `--unmanage-interface` one or more IP addresses, where each one corresponds to an interface to be unmanaged

- `--scopeinfo` the ScopeInfo.xml file to use, defaults to the file actively being used by the webserver (`\usr\ov\www\conf\ScopeInfo.xml`)

- `--dump-scopes` dump scope information about all scopes and the in-scope OVwDB objects for these scopes
--dump-scope dump scope information for a particular scope and the in-scope OVwDB objects for this scope

--dump-definitions if set to "true" the dumped scope information contains scope definitions (default is "true")

--dump-nodes if set to "true" the dumped scope information shows in-scope nodes (default is "true")

--dump-node-interfaces if set to "true" the dumped scope information shows the set of in-scope interfaces for each in-scope node [only useful if --dump-nodes is passed as "true"] (default is "true")

--dump-interfaces if set to "true" the dumped scope information shows in-scope interfaces (default is "true")

--dump-router-overlaps if set to "true" the dumped scope information shows in-scope router overlaps, where a router is found in more than one scope (default is "true")

--dump-node-overlaps if set to "true" the dumped scope information shows in-scope node overlaps, where a non-routing node is found in more than one scope (default is "true")

--logconfig log4j configuration filename

nvmaputil --hide-interface-and-node 10.42.242.21

Hide the interface symbol whose IP address is "10.42.242.21" and also hide the segment-level node symbol that this interface is attached to (for example, pluto.ma.ibm.tivoli.com). If the node attached to this interface was a connecting device, a node symbol found on a network-level submap might be set hidden as well (only if all interfaces that semantically belong to this network were now set hidden).

nvmaputil --delete sig.ma.ibm.tivoli.com

Delete the node sig.ma.ibm.tivoli.com.

nvmaputil --unmanage-node wopr.ma.ibm.tivoli.com
cnatp.rtp.ibm.tivoli.com

nvmaputil --dump-scopes

Dumps out verbose scope information for currently in-use scopes (based on the scopes currently defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --scopeinfo /tmp/ScopeInfo.xml

Dumps out verbose scope information for the scopes defined in /tmp/ScopeInfo.xml (useful if trying to configure appropriate scopes without stopping the webserver to do so).

nvmaputil --dump-scope OurLan

Dumps out verbose scope information for the single scope, OurLan (based on the scopes currently defined in /usr/OV/www/conf/ScopeInfo.xml).

nvmaputil --dump-scopes --dump-definitions true --dump-nodes false --dump-interfaces false --dump-outer-overlaps false --dump-node-overlaps true

Dumps out all scope definitions and node overlaps for the currently in-use scopes. Network service providers might use a command like this to quickly obtain the misconfigured IP addresses to use as arguments in a subsequent call in which the --hide-node-and-interface option is used.

Examples

The following nvmaputil examples involve two simple scopes, both being defined by a single network. The WestfordLAN scope is composed of network 10.141.242, and the LabLAN scope is composed of network 10.103.2. There are two multi-homed nodes that appear in both networks and, therefore, both scopes. These two multi-homed nodes are ptasillo.ma.ibm.tivoli.com (containing interfaces 10.141.242.70 and 10.107.2.100) and wopr.ma.ibm.tivoli.com (containing interfaces 10.141.242.71 and 10.107.2.12).

This example dumps the scope information for the WestfordLAN:

```
\usr\ov\bin>nvmaputil --dump-scope WestfordLAN
Scope : WestfordLAN
Scope Definition
  Resolved In Scope Networks
```
Resolved In Scope Nodes


Resolved In Scope Interfaces


Resolved In Scope Router Overlaps

Resolved In Scope Node Overlaps

Overlapped Scope : LabLAN
  OverlappedInterface[1] : 10.107.2.100 (564)
  OverlappedInterface[1] : 10.107.2.12 (566)

This example dumps the scope information for the LabLAN:

`\usr\ov\bin>nvmaputil --dump-scope LabLAN`

Scope : LabLAN
Scope Definition
Resolved In Scope Networks
Resolved In Scope Nodes
  Hostname[1] : 10.107.2.140 (1047)
  Interface[1] : 10.107.2.139 (1064)
  Interface[1] : 10.107.2.155 (1054)
  Interface[1] : 10.107.2.3 (1040)
  Interface[1] : 10.107.2.1 (1038)
  Interface[2] : 10.107.2.5 (1050)
  Interface[1] : 10.107.2.100 (564)
  Interface[1] : 10.107.2.12 (566)

Resolved In Scope Interfaces
  Interface[1] : 10.107.2.1 (1038)
  Interface[2] : 10.107.2.3 (1040)
  Interface[3] : 10.107.2.5 (1050)
  Interface[5] : 10.107.2.100 (564)
  Interface[8] : 10.107.2.155 (1054)

Resolved In Scope Router Overlaps

Resolved In Scope Node Overlaps
  Overlapped Scope : WestfordLAN
The following example dumps out all scope definitions and node overlaps for the currently in-use scopes.

```bash
/usr/ov/bin/nvmaputil --dump-scopes --dump-definitions true --
dump-nodes false --dump-interfaces false --dump-router-overlaps false --
dump-node-overlaps true
```

Scope : LabLAN
Scope Definition

Resolved In Scope Networks

Resolved In Scope Node Overlaps
Overlapped Scope : WestfordLAN

Scope : WestfordLAN
Scope Definition

Resolved In Scope Networks
Network[1] : 10.141.242 (517) (Network Address: 10.141.242.0)

Resolved In Scope Node Overlaps
Overlapped Scope : LabLAN
OverlappedInterface[1] : 10.107.2.100 (564)
OverlappedInterface[1] : 10.107.2.12 (566)